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Installing Software

Before you can download your points from your GPS and create
your farm map you must install WMC Map. WMC Map is the
software application you will use to draw, edit and print your farm
map.

1.1 Installing WMC Map

WMC Map requires Microsoft Windows XP or Vista to operate.

This section only applies if you are installing on a Mac:

WMC Map can be installed on a mac computer as long as it is
running Microsoft Windows, either from bootcamp or from a
program that boots Windows from OS X such as Parallels or
VMware Fusion.

If you are running VMware Fusion or Parallels, make sure that all
3D acceleration and effects are enabled, otherwise WMC Map will
throw an error until you have enabled them.

Place the WMC Map CD in your CD-ROM drive. The installation
process should automatically begin. If it does not begin to install
automatically, go to ‘My Computer’ and browse the CD drive, then
double click the ‘setup.exe’ file.




The installer may ask you to accept license agreements to install
various items that WMC Map requires to operate correctly — click
‘Accept’ to allow it to install these. Once these other items are
installed the WMC Map setup will launch, guiding you through a
couple of simple steps — you should be able to just click ‘Next’ a
few times and it will install properly.

To start WMC Map, click ‘Start’ then ‘Programs’. There will be a
new menu item called “WMC Technology”. WMC map is under
this menu heading.

1.2 Register WMC Map

You will need to register WMC Map the first time you run the
software. Registration can be done either online or by phone. We
recommend you register online, as we will not always be available
to register your PC by phone.

1.2.1. How to register online

When WMC Map starts up, it will ask you to select how you would
like to register. Click “Register Online”.

Type the registration number as it appears on your CD ROM in
the box at the top of the registration window. Make sure that your
computer is connected to the internet, and then click “Register”.

Your copy of WMC Map will register and you may then use the
software.

1.2.2. How to register over the phone

When WMC Map starts up, it will ask you to select how you would
like to register. Click “Register Over the phone”.

Type your registration number as it appears on your CD ROM,
without any dashes or spaces, in the box at the top of the
registration window. Phone us on the number shown, and we will
give you the second code needed to register your product.

1.2.3. How to get a 30-day trial registration number

If you downloaded WMC Map as a trial, you will have been
emailed a serial number along with a link to download WMC Map.
If you received a CD that did not have a serial number printed on
it, you may click “Get a free 30 day trial online” (making sure that
you are connected to the internet) and fill in your details on our
website. After you have filled in your details, click on “Get Serial
Number”. The following page will then give you your serial
number. Go back to WMC Map and follow the steps in “1.2.1 How
to register online”.



1.2.4. Ordering a full license online
After trialling WMC Map, you may purchase a full license online.

To do this, when you start WMC Map, make sure that you are
connected to the internet, select “Click here to purchase a full
version online”. Your browser will open to a page where you can
select whether you would like to purchase a GPS mapping kit, or
simply WMC Map on its own. Click on the “Buy Now” text next to
the item you would like to purchase.

The next page will show your order and your contact details
should show up. Select which payment method you prefer, then
check your contact details are correct. Modify any details if
necessary then click on “Continue to next step”.

Check your details again, then making sure that you are satisfied
everything is correct, click on “Submit Order”. An invoice will be
emailed to you, and your order will be processed when your
payment is received.

You may register WMC map twice before your registration key
runs out. You may use these two registrations as you choose,
either using one and keeping one spare in case your computer
dies and you need to reinstall, or you may install the software on
two separate computers.

Should you require another activation due to hardware failure
(virus attack, etc)after your two activations are used, you may
contact us to reset your activation uses on our licensing server.
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2. Setting Up your GPS

This section explains what you need to do when setting up your
Garmin Oregon to record GPS points to begin mapping your farm.

If you have purchased this kit and intend to use a different GPS.
You will need to configure it similarly, but the steps taken may
differ slightly.

Many of these settings should already be set for you, but you
should be aware of how to reset them for the best mapping
performance if they are changed.

2.1 Getting Started

Please follow the instructions in the GARMIN Oregon series
owner’s manual for instructions on:

e Tips and Shortcuts
e  Getting Started
e Installing the batteries

e Basic Navigation

11

2.2 Clearing the Memory

Before you start mapping a farm, you need to clear the GPS
memory. This means that no previously saved track logs or
waypoints will be loaded onto your computer, which could be
confusing when it comes to drawing your paddocks.

2.2.1. Clearing Saved Waypoints

When starting off it is a good idea to delete any waypoint that may
be already saved in the GPS’s memory.

1. Touch the Setup icon.

12



2. Then touch the Reset icon. 4. Then when prompted select the Yes icon to delete all the
. waypoints stored in the memory of the GPS unit.

Do you really want to
/ ﬁl:f:aﬂ waypoints?

3. Then touch the Delete All Waypoints icon.

| Reset Trip Data
Timers, Averages, etc.

Delete All Waypoints
Memory Used: 0%

Clear Current Track
Memory Used: 2%

Restore Defaults
To Factory Settings

wif %
D, <
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3. Then touch the Clear Current Track icon.

2.2.2. Clear the Current Track Log
| e |
To clear the current track log:
. Delete All Waypoints
1. Touch the Setup icon.
Memory Used: 2%
To Factory Settings
nff %
[P

4. Then when prompted select the Yes icon to delete
the current track stored in the memory of the GPS

unit.

Do you really want
to clea

.trid:ltogr

2.
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3. Recording points

There are a couple of little tricks to taking points out on your farm
that make drawing up your map on your PC easy. The method for
easily recording and mapping your farm is outlined below.

3.1 Make sure that you start with fresh
memory

To make downloading and drawing your farm map easy, you'll
only want to download the relevant points that you have taken
relating to your farm. The best way to ensure that you only get
these points is to delete any existing track logs and waypoints
from your GPS before you start. To do this, refer to section 2.2
Clearing the Memory.

Handy tip: Whenever you are moving, the GPS will be adding to
the track log. We use the track log to draw lines between
waypoints in the order they were taken, which makes drawing
your map much easier than just looking at a galaxy of dots on
your screen! If you are travelling between paddocks or around a
large obstacle, turn off track logging until you reach the place
where you wish to start recording again.

To turn the track log on and off follow step 3.2.1

17

3.2 Recording Paddocks

Before you record any points, we recommend that you allow your
GPS to “warm up”. When you first turn the GPS on, it will begin
acquiring satellites. Once it locks on to enough satellites, the
accuracy is displayed on the bars at the bottom centre of the
screen while in the main menu screen. The more bars that are
green, the more accurate you're mapping will be. If you touch this
icon a more detailed analysis of the satellites will be displayed,
along with a measured accuracy in the top right hand corner

To be able to draw your paddocks on your computer, you will
need to record every angle of every fence line with your GPS. We
do this by recording waypoints on the angles, and a track log
which shows how the angles join together.

When recording a paddock, start at one post (usually by the gate
is a good start, but it does not matter where you start) and make
your way around the paddock, recording waypoints at all angles

around the fence line until you get back to where you started.

Before you record your first paddock, be sure to turn the track log
ON.

3.2.1. To turn the track log on or off
1. Touch the Setup icon.

18



Track Log
Do Not Record
Record Method
Auto
i interval i
Normal

4. Then select the Record, Do Not Show or Record,
Show On Map icon to setup how you would like the
track to be stored and displayed.

Select Track Recording

2.

rel
T F 4

Do Not Record

-

Record, Do Not Show

a

|
B,

3. Then touch the Track Log Do Not Record icon.

<

19 20



3.2.2.

To record awaypoint (angle post)

Important Note:

If you notice that the bars showing the GPS accuracy
have a red cross through them the GPS will not record
your point accurately. The “red cross” means it could not
lock onto any satellites. The easiest way to correct this is
to turn the unit off then restart the unit once you are out
in the paddock.

21

1. While holding the GPS over the post, touch the Mark
Waypoint.

(Tip: we recommend that you hold the GPS over the post for
several seconds before touching the Mark Waypoint which
will give a more accurate position.)
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2.

Then touch the Save icon. The waypoint numbers will
increment automatically each time you save a new
waypoint.

Your current location
was successfully marked
as waypoint

001

ri

a. Orifitis a special feature that you want to
remember later on touch the Save and Edit
icon. This will allow you to edit the waypoint
properties and enter a name for the waypoint.

The waypoint is now recorded and you may proceed to
the next angle in the fence line where you will repeat this
process again.

23

3.2.3.  Moving between paddocks

When you move between paddocks, your track log will record
where you go. This means that when you download your track log
to your PC, you will see the outline of the paddocks, as well as
lines through your paddocks where you have changed between
them. This is not a problem, and as long as you are aware of the
reason for these extra lines they will not cause you any hassles.

There is a method to remove the lines between paddocks by
saving each paddock as a separate track log. However, the
benefit gained by doing this is outweighed by the extra time
involved setting this system up.

We recommend that you simply record all of the angles as
waypoints and use the track log as a guide to show how they all
join together. After drawing the paddocks in you can then hide the
track log and you’'d never know the lines between the paddocks
ever existed.

When you reach a new paddock, just continue recording
waypoints on the posts as you did in the last paddock. Note; it is
not necessary to re-record points or fence-lines that you already
recorded in the previous paddock.
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3.2.4. Finish recording paddocks

When you have finished recording paddocks it is not necessary to
save your track log. You can simply turn the GPS off and go
home. It will be ready to download your points.

4. Open Demo Map

A demonstration map is included when you Install WMC Map. To
open the demo map, simply click on ‘File’ then click ‘Open Demo
Map’.

25

5. Drawing your farm map (from
GPS points or aerial
photograph)

Once you have collected enough points with your GPS to start
drawing your farm map, you can download them and draw your
farm map using WMC Map.

To find WMC Map click on:

Start menu -> Programs -> WMC Technology -> WMCMap ->
WMCMap

5.1 Opening your farm map file

If you have already started a map and wish to add to or edit it,
click on ‘File’ -> ‘Open’ and navigate to where you saved the farm
map you wish to edit, then open that file.

5.1.1. Create a new farm map

If you are starting a new map, you will need to create a new farm
database.

26



To begin a new farm map: 5.2 Load an aerial photograph

If you have an aerial photograph from Wheresmycows.com, you
may load it in to WMC map and have it appear as a background
layer. Generally if we send you a map file we will not include the

1. Click on the Hew ‘New’ button on the toolbar, then click
‘Farm’ in the drop down list.

2. Fill out your farm details. photograph as part of your file and you will have to import it
3. If you are not in New Zealand, select your country from yourself
the drop down list. If your country is not shown, select If you would like an aerial photograph of your farm, please contact
‘Northern Hemisphere’ or ‘Southern Hemisphere'. WMC Technology Ltd (www.wheresmycows.com), and we can tell
4 Click OK’ you if we have photography of your area.
Now select a place where you would like to save your To load an aerial photograph into WMC Map:
farm map file. 1. Insert the WMC Map CD in your computer.

6. We suggest you browse to ‘My Documents’ and use a Cancel any installation programs that start up.

folder called “Map”.

2
3. Open “My Computer” from your start menu or desktop.
7. Double click on the “Map” folder to open it 4

. In My Computer, Right mouse click on your CD drive and
8. Type a name in the “File name:” text box such as “johns then click “Explore”.
farm map” then press ‘OK’. ) )
5. You will see a folder called “Map” on the CD. Right
Your farm map file is now set up and ready to go. mouse click this folder and click “Copy”.
6. Browse to “My Documents”

7. Click on “Edit” in the menu across the top of the window.
In the drop down edit menu click “Paste”.
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8. The files have now been copied onto your computer.
9. From WMC Map, open a new or existing farm map then
click '™ (‘Import’).

10. Browse to the folder containing the files for your aerial
photograph (My Documents -> Map), and select your
aerial photograph.

11. Press ‘OK’ and your photograph will load. It may take
some time to load, but once it has loaded everything
should run quickly from then on.

12. If you do not see your photograph after it has loaded,
expand the layers tree (press the ‘+' button next to your
farm name in the top left window) the right click on your
photograph layer and click ‘Zoom to layer’.

5.3 Downloading GPS points

This section assumes you are using a Garmin Oregon and USB
cable as supplied with the DIY GPS mapping kit. If you are using
your own GPS, the steps will be similar, but you may need to set
up your GPS to interface with your PC.

29

5.3.1. Connecting Your Oregon GPS to a Computer

This section only applies to users who wish to interface with a
Garmin handheld GPS. This includes our DO IT YOURSELF GPS
FARM MAPPING KIT. If you are drawing your map from an aerial
photograph or have had your farm mapped professionally and do
not need to set up your computer to interface with a GPS, you
may skip to section 5.4.

The Garmin Oregon Series of hand held GPS unit are classed as
‘Plug and Play’ units. This means there is NO need to install any
software drivers. To interface with your Garmin GPS with your
computer just follow the steps outlined below.

Note: Before attempting the following steps ensure you have the
USB cable that was supplied with your Oregon GPS unit

Steps:
1. Lift the weather cap on the bottom of the GPS unit.

2. Insert the smaller connector on the USB cable into the
mini-B jack on the bottom of the GPS:

3. Connect the other end of the cable to the USB port on
your computer.

Note: Once you have connected your GPS it may take a few
moments for your computer to recognise the GPS unit. If it is
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the first time you have connected your GPS to your computer
it may take a few minutes for it to automatically load its
software.

You are now ready to send data between your GPS and PC.

Steps to import GPS points

1. Connect your GPS to your PC using the USB cable
supplied.

2. Power on your GPS

3. Assuming you have created your farm file (section 5.1)
and still have the file open ready to go, click on
‘Download from GPS’ in the Menu at the top of the
screen.

4. Ensure that the GPS type is set to Garmin and port is set
to USB and click “Connect to GPS”.

5. Make sure that your GPS is connected and switched on
and press OK in the warning window that pops up. Your
GPS waypoints and tracks will then show up in the
window.

6. Be sure to select the waypoint and all tracks, then click
‘Insert selected items into map’.
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7. Your points and track will now have a heading in your
map beneath the name of your farm on the left hand side
of the screen (you may need to press the + next to the
name of your farm to show the GPS layers you just
imported). If you cannot see the downloaded points in the
main part of the screen, you may need to right-click on
one of your layers and select ‘Zoom to layer’.

The three common GPS layers created from a download are:

GPS Lines Straight lines between waypoints in the order
they were recorded.

GPS Points Waypoints you have recorded, such as fence
angles.

Track Lines A track log, showing everywhere you went while
recording.

You may show or hide each of these layers by clicking on the
checkbox next to the layer name in the tree on the left hand side
of the screen. They may also be renamed to something more
meaningful to you by right clicking on the layer name and
selecting ‘rename’.

Note also that you may change the characteristics of each layer,
such as point size, point type, line width and colour, and whether
waypoint names are displayed. To do this, click on the layer name
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you want to edit. In the box below the layer tree, a properties box
comes up in which you may alter the characteristics of that layer.

5.4 Draw your map

5.4.1.

Drawing paddocks

To draw your paddocks onto your map, you must first create a
paddocks “layer”.

1.

a
To create a layer; Click on Mew ‘New’ then ‘Polygon
Layer (paddock/area)’. A new polygon layer will appear in
the layers tree on the left hand side of your page.

‘E B o)

New Polpgon Layer

If you do not see the new polygon layer, you may need to
expand the tree by clicking the ‘+’ sign next to your farm
name at the top of the tree.

It is important to name each layer with a name that
describes what that layer is. That way you can easily edit
and display or hide layers. To name the layer you just
created, right-click on the layer name (New Polygon
Layer) then left-click on ‘Rename’. You can then change
the name. Type “paddocks”, as this layer is going to be

33
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your paddocks layer. Press ‘Enter’ to secure the name
change.

Making sure that the ‘Paddocks’ layer is highlighted, click

], 4
on the &dit ‘Edit’ icon at the top of the page, then click Add
‘Add’. This will enable you to draw your paddocks onto
your farm map.

Using your track log and Waypoints (If you are drawing
from GPS points), you should be able to see where you
went on your farm, and work out where the fences should
be. If you are drawing from a photograph, you can see
where to draw your fences from the photo. You must
draw each paddock separately.

Drawing paddocks is easier when you have zoomed in to
the paddock you wish to draw. To zoom in, hold down
the shift key on your keyboard (this temporarily takes
WMC Map out of draw mode and into view mode). While
holding down shift, move your mouse to where you want
to zoom in to and then click and drag upwards to zoom
in, or click and drag downwards to zoom out. Right
clicking and moving the mouse pans the map.
Remember to hold down shift while you zoom or you will
start drawing paddocks!



To draw a paddock, take your finger off the shift key then
click on one of the corner points of the paddock, then
move your mouse to the next point along the fence line
and click on that corner. Continue to do this until you
have clicked on all corners of the paddock. Once you've
finished, click back on the first point you used to start
drawing your paddock, and the area will fill in a solid
colour. Your paddock has been created.

To cancel drawing a paddock part way through, press the
“Esc” key on your keyboard or click on the cross in the
grey box at the top right hand side of the map window
(not the small cross that closes the program though!).

If you make a mistake while drawing a paddock, press
backspace on your keyboard to erase the last point you
clicked and then click in a new position.

Holding down the ‘Ctrl’ key while clicking temporarily
disables automatic snapping to existing points. This will
enable you to click near an existing point without the
cursor jumping onto it.

Note, if the paddock does not appear to be filled in a solid colour,
check that the ‘FillColour’ property is not set to white, transparent,
or another hard to see colour. To change the colour of the
paddock fill, while the paddock layer is selected in the layer tree,
click on ‘FillColour’ in the properties box, and click another colour

35

to change the colour. You may also change other properties
including the line colour, text colour, and whether text including
paddock names and areas is displayed.

Handy Hint: To move around on the map while in edit mode,
hold down the shift key while clicking and dragging the mouse.

Shift + left click drag = zoom
Shift + right click drag = pan

You can then reposition the map and continue drawing
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5.4.2. Naming paddocks

After creating your paddocks, you may want a text name shown in
each paddock.

To name paddocks:

1. Click on the layer (in the layer tree on the left hand side
of your screen) you want to show names of (eg,
paddocks).

2. Make sure that ‘'Show Names?’' is set to ‘True’ in the
properties window.

- Sample Farm
Paddacks

Ez- A
CER A
E _General
Show Areas? True <:I
Show Names? -
Show Points? False
Show In Key? True
Use 30 Areas? False
Text Size 10
Area Decimal-Places 1
= Colours
Line Colour [1 LightGray
Fill Colour [ Transparent
Test Colour Il Black
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[P
3. Clickon E?t ‘Edit’ then Select ‘Select’ in the menu bar at
the top of the screen, then click on the paddock you want
to name. The properties box then updates to the
properties of that particular paddock.

- Sample Farm
Paddacks

= A

3=" £
B _Generd <——

Enter Name Here|
igw Tewt? True
E Appearance
Text Rotation 1]
Text Scale 1
Fill Dpacity 1
E Colours
Fill Colour [ LightGreen
= Stats

4. Enter the name for that paddock in ‘Name’ and press
Enter.

a. Refer to section 5.5.5 “Rotate text” for
instructions on rotating and changing text scale.

5. You may then select and name other paddocks.
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5.4.3. Displaying paddock areas

WMC Map automatically calculates the area of paddocks as they
are created. To display the area of paddocks, click on the
paddocks layer then in the properties or that layer change ‘Show
Areas?’ to ‘True’. This can also be done by double clicking on
‘Show Areas?’. Note the WMC Map trial will show all paddock
areas as ‘Oha’. When you register with a full license the areas will
show correctly.

5.4.4. Select measurement units

To change measurement units between metric and imperial units
click on the ‘Edit’ menu then scroll down to ‘Units’. To the right of
units, select imperial or metric.

5.4.5. Editing paddocks

After you have drawn your paddocks you may edit them. As you
edit the paddock, the size of your paddocks will be continuously
updated.

To edit paddocks:
1. Select the layer you want to edit, in this case, paddocks.

. 3, ) &
2. Click on it ‘Edit’, then move ‘Move’
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3. Select a fence line or a corner of two or more fence lines
and click and drag to alter the paddock(s).

To add angles in a fence line:

1. Select the layer you want to edit, in this case, paddocks.

% . . 5
In =it ‘Edit’ mode, click on ==t ‘Insert’
Click in the position on the fence line you would like to

4
create the angle, then use the e ‘Move’ tool to drag the
newly created angle around.

You may edit other layers by clicking on the layer name and
dragging points around in a similar fashion.
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5.5 Drawing other features

After you have drawn in all of the paddocks, you may add in any
other features you wish. To do this, you may either “draw them in
by hand”, or go and take more points with your GPS and
download them in to your map.

5.5.1. Recording other features with your GPS

Clear the memory (explained in section 2.2 “Clearing the
Memory”), then go out and record more waypoints or track logs as
explained in section 3 “Recording points”. You can record creeks,
waterlines, tree plantations, trough locations, or anything else you
wish to record. You may record features such as creeks as a
sequence of points, and individual points such as troughs
separately.

5.5.2.  Drawing lines and points

After downloading your GPS points on your PC, you may draw
polygons (bounded objects such as paddocks, buildings, etc),
polylines (such as creeks, roads, tracks), and points (such as
troughs, power poles, etc).

You must create a new layer for each separate item you want to
draw before you can draw it on the map.

a1

Steps to drawing features in new layers:

1. Click new ‘New’ at the top left of the screen and create a
new layer that corresponds to what you want to draw.

2. Right-click on the new layer you have created, then click
‘Rename’ to change the name. Type a new name and
press Enter.

], 4
3. Click on &di ‘Edit’ then 4dd ‘Add’ to start drawing. You
might find it useful to turn off some previous layers to
make it easier to see what you are drawing.

4. To finish drawing a polyline (creek, etc), click on the tick
button _‘ in the top right hand corner of your screen.
You may click on the cross “ 1 to cancel it.

5. Polylines and points can be named the same way that
you name polygons.
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. . 0O
5.5.3. Drawing parallel lines 1. Click "ew ‘New’ at the top left of the screen and then

. . . . . click on ‘Text' to create a new text layer.
This feature is only available in polyline layers.

2. Right-click on the new layer you have created, then click
‘Rename’ to change the name. Type a new name (such
as “Text Notes” and press Enter.

If you wish to replicate a line parallel to the original:

%
1. With your polyline layer selected, click on &dit ‘Edit’ then
4

add ‘Add’ to start drawing. At the top right of the drawing

window click on <>’. (parallel line tool).

], 4
Click on &dit ‘Edit’ then 4dd ‘Add’. Be sure that your new
text layer is also selected by clicking on it in the layers
tree.

2. Click on the original line you wish to replicate, it will then Click in the position you want to place your text.
turn pink. Drag the mouse out to where you want the
parallel line to be placed and then click to place it. You Enter your text in the box provided, then click ‘OK’
will notice another pink line with a distance on it telling 4
you how far away you are placing the new line. To move your text, click on meve ‘Move’ then move your
mouse to the centre of your text, then downwards until
5.5.4. Drawing Text you see the cursor change to a pen with a black dot next

X
To add text notes to your map, you can create a text layer, then toit #*. Click and drag to move your text.

place and move text around on your map. You may make several
text layers and give them different names. 5.5.5. Rotate text

To create a text layer and add text: If your text does not fit inside a paddock, you may wish to rotate it.

To rotate text:
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1. Click on the layer that contains the text you wish to rotate appear in front of them. To change the position of a layer on the
(e.g. paddocks layer) layer tree, right click on that layer and click one of the move

N options in the menu that appears.

2. Click on the &edit ‘Edit’ button.

5.6 Save your map.
It is a good idea to save your map frequently while working on it,

4. Click inside the paddock, or on the text you wish to rotate as well as when you have finished before you close it. Saving is
simply done by clicking on the Save button.

[P
Click on the Select ‘Select’ tool

In the properties section (the box below the layer tree
box) is a section labelled ‘Appearance’. Below Note: If you are in ‘Edit’ mode when you save, the program will

‘Apparance’ is ‘Scale’ and ‘Rotation’. ask you if you want to save any changes you may have made —
clicking ‘Yes’ will save the changes you have made, clicking ‘No’

a. Scale properties can be set between 0 and 1. will restore the map to its condition before you entered ‘Edit’

b. Rotation properties can be set between -360 mode, and will then save it.
and 360
6. To change scale or rotation properties, simply click on 5.7 Key, scale, north arrow and border

the property and type in a new number, then press enter.
Your text will then update to reflect your changes.
Repeat this process until the text looks how you want it.

If you have many layers of information on your map, you may
want a key and border to make your map look more complete.

Insert a key:
5.5.6. Layer order

a
1. Click on the m=w ‘New’ button, then click ‘Key’ in the drop

When you create a new layer, it is automatically placed at the top down menu

of the layer tree. This tree shows the order layers are drawn on
the map. Layers that appear higher on the tree than others will
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Move your mouse over the map and your key should
appear in the middle of the screen.

%
To move your key, click on the =it ‘Edit’ button at the top
of the window, then be sure to select the ‘Key’ layer in
the layer tree.

4
Click on the meve ‘Move’ button at the top of the screen.

Place your mouse over the top item in the key layer and
then click and drag to move your key around on the
screen. Place it somewhere it will print but not obstruct
your map.

As you show or hide layers on your map you can update
the key by clicking twice on the tick to the left of the Key
layer in the layer tree to hide and then show the key.
When the key is redrawn it will include whatever layers
are currently being displayed on the map

You may change the key size, text colour, border colour,
thickness and corner radius in the key properties section
(below the layer tree section).

To enter extra text at the bottom of the key, use the
‘Extra Text’ property in the key properties.

a7

#
Click the vew ‘View' button, then ‘Yes’ to “Accept Data
Changes?” to confirm your key.

Insert scale and north arrow:
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Q
Click on the Mew ‘New’ button, then click ‘Scale in the
drop down menu.

Move your mouse over the map and your scale and north
arrow should appear in the middle of the screen.

%
To move your scale, click on the =it ‘Edit’ button at the
top of the window, then be sure to select the ‘Scale layer
in the layer tree.

4
Click on the mve ‘Move’ button at the top of the screen.

Place your mouse over the top left hand corner of the
scale layer and then click and drag to move your scale
around on the screen. Place it somewhere it will print but
not obstruct your map.

As you show or hide layers on your map you can update
the key by clicking twice on the tick to the left of the Key
layer in the layer tree to hide and then show the key.



When the key is redrawn it will include whatever layers
are currently being displayed on the map

You may change the scale size, text colour, border
colour and thickness and corner radius in the key
properties section (below the layer tree section).

Insert a border:

Q
Click on the Hew ‘New’ button at the top of the screen,
then click on ‘border’

When you move your mouse over the map you will see a
border appear in the centre of the screen.

%
Click on the =it ‘Edit’ button at the top of the screen, then
select the ‘Border’ layer in the layer tree by clicking on

+
‘Border’. Click on the mve ‘Move’ button.

Drag each corner of the border to make the border
surround your map and key. To drag a corner, move the
mouse near the corner of the boarder and notice when
the curser changes to a pen with a black dot just below it

;\ when you move the mouse just inside the corner of
the border. When you see the cursor change click and
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drag the corner. Do this for all four corners to place your
border in the correct position.

You can change the border thickness and colour in the
properties section.

#
Click the vew ‘View' button with the picture of a camera
on it, then ‘Yes’ to “Accept Data Changes?” to confirm
your border.



6.

Print your map

To print your map, simply select the layers you would like to print
from the tree on the left hand side of the screen. You may like to
make the paddocks layer transparent (to save ink) by changing
the ‘Fill Colour’ to transparent in the properties box (You will have
to select the paddock layer, then you will see the properties for

that layer).
To print:
1. Before printing, be sure that you have saved your map.
®
2. Select the rrmt ‘print’ icon from the menu bar.
3. A blue box representing the boundaries of your page will
appear on the screen. If you want to print landscape
(page rotated 90°) rather than portrait, click on ‘File’ then
‘Page Setup...". Select ‘Landscape’ and click ‘OK’. Move
your mouse over the map to update the display and show
your different page orientation.
4. Move (right mouse button and drag) and zoom (left

mouse button and drag) the map until it is displaying how
you want it to print on your page.
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5.

If you would like to preview what the printed sheet will
look like, you can click ‘File’->'Print Preview’. This will
open up a preview window, and after a few seconds your
preview should appear. To close the Preview window
click the ‘Close’ button or the ‘X’ in the upper right corner.

Click ‘File’ -> ‘Print’ and select your desired printer and
printing options, then press ‘OK’ to print your map.



7. Send your map to WMC
Technology

For support with your map, or if you want a wall map, whiteboard,
or pad of handout maps printed, you may send your farm map to
WMC Technology Support.

7.1 Send your map to support using your
email program:
1. Open your email program and create a new message
2. Attach your map file.

a. Find your map file. If your computer is set to show
filename extensions it will end in .wmc’ and should

have a Wheresmycows logo o) for its icon.

3. Write your reason for sending your file in the body of the
message (support request, to print maps, etc). If
requesting map prints, please state what size maps you'd
like printed, whether you'd like them laminated or
padded, and the quantity you want.

4. Send your email to support@wheresmycows.com
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8. Upload points to your GPS

After you have drawn your farm map, you may want to upload

points back to your GPS so that you can find them in the paddock.

To upload a point:

3,
1. Click the &dit ‘Edit’ button in the menu bar.

f
2. Click serdTacrs ‘Send To GPS’
Click the point on your map that you would like to upload.

4. Give your waypoint a name and optional comment, then
click ‘Upload waypoint to GPS'. Follow any further
instructions on screen.

5. Your point is now uploaded to the GPS. Repeat this

procedure for any other points you wish to find out on
your farm.

Some GPS units will let you upload an entire layer at a time from
WMC Map

To upload a layer:

1. Right-mouse-click on the name of the layer that you
wish to send to your GPS unit
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2. Click on “Send to GPS”

3. In the next window that comes up, click on “Upload
Layer to GPS".

9. Finding your uploaded points
out on the farm

Your GPS can be used to find points you have created on your
map on your PC out on the farm. To do this you must first upload

the points you wish to find out on the farm as explained in section
8.

Steps to finding points:

1. OQutin the paddock, power up your GPS and wait for it to
initialise and lock on to enough satellites to give you a fix.

Press Where To? from the main menu.
Then press Waypoints.

Select the waypoint you would like to go to from the list.

A A

The waypoint you have selected will then come up on the

screen. If you are happy this is the correct waypoint,
press the Go button.
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6.

The map screen will show up, showing a line that looks
like a road between your current position and the point

you are navigating towards. Use the + and - buttons to
zoom in and out.

Press Compass from the main menu to view the
compass screen which has an arrow showing you which
direction to walk in, and tells you how far you need to
walk to find the point.

To find another point, simply repeat this procedure from
step 2.
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10. Common tasks

10.1 Zoom

Zooming in and out in the view and print modes is achieved by
holding down the left mouse button on your target and dragging
the mouse up or down.

%
In =it edit mode, you may zoom by holding down the shift key on
your keyboard and following the same procedure as above.

You may zoom to show a complete layer on the screen at once by
right clicking on the layer on the tree on the left of the screen, then
clicking on ‘zoom to layer’. This is often handy if you “loose” your
map due to zooming too far in, out or elsewhere and cannot find it.
Simply right-click on the top level of the layer tree, then click on
‘zoom to layer’.

10.2 Pan

Panning around your map in the view and edit modes is achieved
by holding down the right mouse button and dragging the map.
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%
In =it edit mode, you may pan by holding down the shift key on
your keyboard and following the same procedure as above.

10.3 Ruler

The Ruler tool enables you to measure distances and areas on
your map. Also, when in ruler mode, when you hover over a GPS
point, the latitude, longitude and altitude of that point will be
displayed at the bottom of the screen. To use the ruler tool click

on the Ruler ‘Ruler’ tool when in v?w View or E?t Edit mode. You
can then click on a point to start your measurement from. A pink
line is drawn from this starting point to the current mouse position.
Clicking again will continue the line and you can carry on adding
segments to your measurement.

Associated with this pink line are three measurements which can
be viewed in the properties area:

Distance - the total length of pink line (in metres)

Distance 3D — when measuring between GPS points, this value is
the distance between points incorporating change in elevation.

Circumference - the total length of the pink line plus the length
from the end of the line back to the start position (if you drew 3
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sides of a square, it would give you the total circumference of that
square).

Area - the total area enclosed by the ‘Circumference’.

AltitudeChange — Measures the change in altitude between two
GPS points. (Measures the change between the last two clicked
points).

Once you have finished with your measurement or want to start a

new one, you can use the | ‘Tick’ or -~/ ‘Cross’ button in the top
right corner of the display to remove the pink line.

10.4 Send shapes between layers

Occasionally when you are drawing, for some reason you may
draw a polygon in the wrong layer (e.g. you might complete a
shape that becomes a ‘building’ because the building layer is
selected when you wanted it to be a paddock in the paddocks
layer.

Rather than having to delete the shape and then re-draw it in the
correct layer, you can send the shape to another layer. To move a
polygon from one layer to another do the following:
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Make sure the layer you want to move the shape
from is selected

2
Click on the serd Telayer hutton at the top of the

screen.

Click on the polygon that you want to send from one
layer to another.

A window will pop up asking you to select which
layer you want to move the shape to. Select the
layer you want to move it to and then click “OK”

You then have the option to delete to original
polygon. In most cases you will want to delete the
original so click on “Yes”.

You have now successfully moved the polygon from
one layer to another.
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10.5 Show lengths of lines in polygon
layer

Click on the polygon layer in the layer tree that you wish to show
the lengths of individual sides for.

Change the “Show Lengths?” property in the properties area to
“True”

10.6 Download the latest version of
WMCmap

The latest version of WMCmap is available on
www.wheresmycows.com

If you go to www.wheresmycows.com and click on the ‘Support’
link, then ‘Software updates’ you can download and install the
latest version on your PC.
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11. Advanced Operations

These operations assume a general familiarity with WMC Map
and WMC Map’s common operations. You may need to refer to
earlier parts of this booklet if you are not very familiar with WMC
map.

11.1 Subdividing or re-fencing Paddocks

You may have mapped your farm with the idea of subdividing
paddocks or re-fencing in mind. This can be accomplished in one
of several ways. We have created a step by step guide for you to
follow to make subdividing and re-fencing easy. From here on we
will call it ‘re-fencing:

In this section, we will work through an - b e
example to show how to refence the five

paddocks in the lower left corner of the >
image on the right into three equal sized
paddocks.

1. Calculate the total area that you
wish to split up.

a. Create a new polygon layer and label it “Areas to re-
fence” .
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b. Draw a polygon around the boundary of the area you
are going to subdivide. This will give you the area that
you wish to subdivide. You can then figure out how
many fields/paddocks you want in that area and what
size they are going to be.

Change the “Text Colour” of the “Areas to re-fence” layer to red
or something other than the colour of the paddock text so that
you can see the total area that you are going to re-fence.
Change the “Area Decimal-Places” property to ‘2’ to get a more
accurate area figure to divide into how many paddocks you
desire.

By this stage you should
have something similar to
the image to the right. The
gray area (12.25ha) is the
area that we wish to
subdivide. This layer is
below the paddock layer and
we can see the existing
paddocks over the gray
area.

In this example we wish to
divide the 12.25ha into three equally sized paddocks of about
4.08ha each.

In the layer that you wish to create your subdivided polygons in
(generally your “paddocks” or “fields” polygon layer), use the



1.3ha

4 ~.
Mave move tool or 4dd add new polygons in to draw your 24ha e 1.7ha
subdivided areas. | |

a. Tomake it easier to view what you are doing, right '
click on your polygon layer that you are drawing your | [
new fields in and then click “Move to top”. This will | [ ’ P
bring the layer to the front so that you can view it. | I
Make sure that you have the layer “Fill Colour” set to | || | ™~
“Transparent” in the properties section. | |
|
The figure to the right shows I 4.1ha | |
l : 4.1ha / |I
/ 4.1ha i

our paddocks drawn in

(5.01ha, 3.89ha and | ‘ - | |
3.36ha). Fill colour has been [ = | ' ] '
changed to orange to make | | I' . f o
it easier to see the fields. : , ' I i / ST TN

| el |

X 4$> | 12 2% f A Dira. { | I
Using the Meve move tool, = _ ~ I /
drag the corners of the | ;' | ~— ] f f
polygons around to get your ! | { |
field the desired size. i Y
The image to the right shows the fences moved to give the At the end you should see your re-fenced paddocks similar to the
desired size (4.08ha) paddocks. It may be necessary to insert image above.

ints in li t t bends wh i ddock . .
pon's T INes fo create new bends when moving pacdocks You can then upload new corner points to your GPS as explained

in section ‘8 Upload points to your GPS'.

around to suit.

Turn off the “Area to re-fence” layer by deselecting the checkbox

next to the layer name.
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11.2 Calculate 3D surface area of
paddocks

Instead of using a 2D planar area, in hilly areas there will actually
be more surface area in a paddock than a planar area calculates.
You can use your GPS and WMC Map to calculate the surface
area of an entire polygon layer. To do this you need both a
polygon layer (usually your paddock layer) and a set of points
containing altitudes for WMC Map to calculate the surface area

from.

To create your 3D surface area:

1.
2.

Draw up your paddocks and map as you would normally.

Clear your GPS memory, then go out and mark
waypoints in the area that you wish to calculate a 3D
surface area for. To do this we recommend taking points
at the top and bottom of hills and valleys, and where ever
the slope changes. To mark points, follow the steps
outlined in Section ‘3.2.2 To Record a waypoint’. There is
no need to label your points. The more points you take,
the more accurate the 3D area will be.

Download your altitude waypoints into WMC Map as you
would normally.
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10.

11.

It is a good idea to rename your new points “Altitude
points” or something similar so that you do not get mixed
up and select the wrong layer for WMC Map to use inits
calculation.

Now is a good time to save your work.

‘Right mouse click’ on the layer that you want to create a
3D surface area for (EG, paddocks).

Select “Calculate 3D areas”.

Select your altitude points layer to include in the
calculation by clicking the checkbox next to the name,
then click OK.

At this stage WMC Map may take a while to calculate the
3D surface areas. Don't worry, this is normal. Just wait
for it to finish and you will be able to continue working like
normal.

If you now click on your polygon layer for which you just
created a 3D surface area calculation, you will see in the
properties under the Measurements section that there is
now a “Total Area” and a “Total Area 3D” property.

If you change the “Use 3D Areas?” property to true, the
areas displayed in the paddocks will be the 3D surface
area that you just calculated.



12. Save your project to retain these areas.

11.3 Move entire Layer

Due to the inherent inaccuracy of handheld GPS over time, you
may find that if you record some paddocks one day, then go back
and record them again next month, the whole paddock could have
shifted by a few metres. This could also be a problem if you record
some paddocks, then later go back and record more to find that
they do not line up. To get around this problem, we have created
the “Move entire layer” tool.

To use the Move Entire Layer tool to line up your paddocks:

1. When you are recording points, mark a waypoint on an
existing point that you recorded last time. Eg, a trough or
angle post.

Download the new points as you would normally.

When the points are downloaded, right click on the new
layer you want to move, and then select “Move Entire
Layer”.

4. Type in the amount by which you want to move your
points in each direction (for left or downwards, type a
negative sign before the number. The unit is metres).
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5. Click ‘OK’ and your entire layer will move by this amount.
You may need to have several tries at moving the layer
before you get it exactly where you want it.

Handy tip: Before moving the layer, use the measure tool to find
out how far in each direction you need to move the layer.

11.4 Merge Layers

Sometimes you might want to merge several layers into one (eg, if
you have taken several sets of GPS points that you wish to
combine). To merge layers:

1. Right click on the layer that you want to merge your
layers into.

Select ‘Merge Layers into this’

Check (click on) the white box next to any layers that you
want to merge into the layer that you right clicked.

4. Press ‘OK’

After the layers are merged, you will be asked if you wish
to remove the layers that you merged into the first layer.
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Select ‘Yes’ or ‘No’ depending on whether you wish for
the layer to stay as a separate layer.

11.5 Export to shapefile or dxf (autocad)

If you have another farm management program such as
FarmKeeper, P-Plus or Concepts Rural Suite, you may export
your map from WMC Map and import it directly into your farm
management program. Each layer is exported as a shapfile or dxf,
which will load directly into other farm map or GIS software.

To export a shapefile or dxf:
1. Right-click on the layer you wish to export

2. Click ‘Export’ then in the submenu ‘Export to Shapefile’
or ‘Export to dxf'.

3. If you choose to export to dxf, you will need to specify if
you want to export your points with easting/northing (NZ
Map Grid) or lat/long coordinates.

4. Select a location to save your file and type a name, then
press OK.

5. Your layer has now been exported as a shapefile or dxf
and you may import that file from your farm management
program.
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11.6 Export to Tumonz

Tumonz mapping software covers the whole of New Zealand. To
export your farm map and then import it into Tumonz:

1. Right-click on the layer you wish to export
2. Click ‘Export’ then in the submenu ‘Export to GPX'.

3. Select a location to save your GPX file and type a name,
then press OK.

4. Your layer has now been exported as a GPX file and you
may import that file from your Tumonz.

Import in Tumonz:
1. From Tumonz click on ‘Tools’ then ‘GPS manager’
2. Click on ‘Load and Save Files’
3. Select and open the file you exported in the steps above.
4

Expand the track or point tree on the left side of the
window so that it shows all of your shapes in the file you
imported.

5. Click on the first shape, then hold down the shift key and
click on the last one to select them all.

6. Right mouse click on one of the selected items.
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7. Inthe menu that pops up, go to ‘Map’ then click on ‘Copy
item to user map objects’.

8. Your file has now been imported into Tumonz and you
may change it into a set of polygons or perform other
operations with it.

11.7 Export and Import KML (Google
Earth)

Exporting to KML files allows you to view all or part of your farm
map in Google Earth.

If you do not have the Google Earth software installed on your
computer it can be downloaded from the Google Earth website
(www.earth.google.com). Once you have installed Google Earth
just double click the exported KML file to view your layer.

11.7.1. View in Google Earth:

1. Right-click on the layer you wish to export
2. Click ‘View in Google Earth’.
3. Select a location to save your KML file and type a

name, then press OK.
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11.7.2.

P WD PR

5.

11.7.3.
1.
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Your layer has now been exported as a KML file. If
you have Google Earth installed on your computer it
will automatically start up and display your exported
layer.

Note: Some graphics cards have issues trying to
display Google Earth at the same time as WMC
Map. If you run into trouble, we suggest exporting a
KML file using the method below, then closing WMC
Map before you view your map.

Export KML File:
Right click on the layer you wish to export.
Hover the mouse over “Export".
Click “Export to Google Earth (KML)”

Select a location to save your KML file and type a
name, then press OK.

Your layer has now been exported as a KML file.

Import KML File:

Save a KML file that you have created in Google
Earth. NOTE: When saving your file check that it is



not saving a KMZ file which is the Google Earth
saving default. Be sure to select KML in the save
dialog box.

From WMC Map, open a new or existing farm map
then click '™ (‘import’).

Browse to the folder containing your KML file, and
select your KML file to import.

Press ‘OK’ and your file will load.

If you do not see your data after it has loaded,
expand the layers tree (press the ‘+" button next to
your farm name in the top left window) the right click
on your imported layer and click ‘Zoom to layer’.

11.8 Custom point images

Have you tried importing points and selecting the ‘trough’ point
type in the points properties? You can create up to 20 custom
point types to insert into your maps.

To create a custom point you must save an image as a windows
bitmap (.bmp) file using a program such as ‘paint’ (found under
the accessories section in your start menu).

Save your images as customl1.bmp, custom2.bmp, etc in
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‘C:\Program Files\WMC Technology\WMCmap\textures\texture’

You will then be able to use your .bmp image as a point type by
selecting that custom point from within WMCmap.
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11.9 Centre-pivot irrigators

WMC Map allows you to draw full circle and part-circle centre-
pivot irrigators.

1.

Q
Click on the Hew ‘New’ button at the top of the screen,
then click on ‘Centre-Pivot Layer’

You will notice a new layer called “New Pivot Layer”
appears at the top of the layer tree. Click on the text that
says “New Pivot Layer” to make it selected (it will turn
blue).

Q &
Click on &dit ‘Edit’ then #dd ‘Add’.

Click in the position you want to place the center of your
pivot. (You can move it later, so don’t need to place it too
accurately to start).

A window will appear asking you to enter some
information about your irrigator.

a. Enter a start angle of 0 and end angle of 360 to
draw a full circle pivot.

7
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b. Enter wheel track radii (distance from center) to
draw in wheel tracks. Enter radius and then click
on “Add value”. Repeat this process for each
tower.

i. A handy tip is to put a wheel track at
2m (or 7°) so that you can see where
the centre-point of your pivot is.

c. Sprinkler tracks and endgun radius is optional.

d. Click OK to create your irrigator.

4
To move your irrigator, click on moe ‘Move’ then move
your mouse to the centre of your pivot, then downwards
until you see the cursor change to a pen with a black dot

¢*_Click and drag to move your irrigator.

[P
To modify the specs of your irrigator, click on Select
‘Select’ and then click on the centre of the irrigator you
wish to edit.



